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Dear Colleague,

So you want to print some labels?  This issue is all about labels. I hope you enjoy it 
and I hope you all had a Happy Thanksgiving and were able to try our PocoDoc© 
free service i.e.  www.PocoDoc.com.

Sincerely,
Gerard T. Capraro, Ph.D.
President

POCODOC  UPDATE

PocoDoc© is an advanced optimization tool which cuts the bloat, making your 
files smaller, faster and more manageable. In addition, the files stay in their 
original format.

Our intent for PocoDoc© was to provide a service to users who send Office 
documents as attachments through email and/or to users over low bandwidth (i.e. 
mobile) connections. Some of  you know many email providers impose a limit on 
the size of  attachments, which is why we want to shrink documents. Admittedly, 
our free service at PocoDoc.com requires sending the large file to our server and 
sending the resultant file back to the user through email, if  it's size hasn't been 
reduced enough, poses an issue. We chose email to deliver the optimized files 
because it is something most people use.

We also intelligently compress any images contained within the document. This is 
controlled by the several levels of  optimization. PocoDoc© tries to compress the 
images to meet the size constraints of  the user while maintaining the highest 
perceived quality. Again, our thought was that not being able to send a document 
at all or in a timely manner because of  size constraints is worse than sending a 
lower quality version on time.

We're lifting the limit on the size of  the documents submitted to our online version 
of  PocoDoc©. However, the time it takes to submit a file is limited by the user's 
internet upload speed, which my be slow. We also take users' privacy very seriously. 
All email addresses and files are used internally for testing purposes only. We will 
not distribute this information to any third party, nor will we use it to spam our 
users.

Lastly, we are coming out with a free lite desktop version which operates in a 
similar manner except the optimized files are returned through the lite version and 
not through email. This should be out by Jan. 2011.

PocoDoc© has been reviewed by Gizmo’s Freeware. Here’s the link to the article. 
http://www.techsupportalert.com/content/online-office-file-shrinker-has-
potential.htm And if  you want to try PocoDoc© - it’s free at www.PocoDoc.com .
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PRINT LABELS BY USING EXCEL DATA IN A WORD MAIL MERGE

This applies to Microsoft Office Excel 2003 -

By creating a mail merge in Word, and then linking to a list in Excel, you can turn worksheet data such as the addresses of  your customers 
into printable mailing labels.

1. In Microsoft Excel, set up the data to use in the mail merge.
1. Make sure the data is in list format; each column has a label in the first row and contains similar facts, and there are no blank 

rows or columns within the list. You’ll use the column labels to specify what data goes where in the mail merge. 
2. Make sure the column labels clearly identify the type of  data in the column; this helps you select the right data as you construct 

the mail merge. For example, labels such as First Name, Last Name, Street Address, and City are better than Column 1, Column 
2, Column 3 and Column 4.

3. Make sure you have a separate column for each element that you want to include in the mail merge. For example if  you’re 
creating form letters and want to use each recipients first name in the body of  the letter, make sure you have a column that 
contains the first names, rather than a single column with both first and last names. If  you want to refer to each recipient by title 
and last name, such as Mr. Smith, you can use a single column containing both titles and last names or use one column for title 
and another for last name. 

4. To make the list easy to find when you select it for the mail merge, give it a name:
1. Select the entire list.
2. On the Insert menu, point to Name, and then click Define.
3. Type a name for the list. 
4. Click Add and then click Close.

2. Save and close the workbook that contains the data. 
3. Switch to Microsoft Word.
4. On the Tools menu, point to Letters and Mailings, and then click Mail Merge Wizard.
5. In the first two steps of  the Mail Merge Wizard, select the document type and start the document.  If  you are creating mailing labels, 

click Labels in Step 1, and then click Label Options in Step 2 to select the size and type of  labels to print. 
For more information about these steps, see Word Help.
6. In the third step, under Select recipients, click Use an existing list, and then click Browse.
7. In the Look in list, click the folder in which you saved the workbook with your data, click the workbook, and then click Open.
8. In the Select Table dialog box, locate and click your list. Make sure the First row of  data contains column headers check box 

is selected, and then click OK.
9. In the Mail Merge Recipients dialog box, click any column labels in your data that correspond to the Word identifiers on the left. 

This step makes inserting your data in the form documents easier. For more information about matching fields, see Word Help.
10. If  you want to include only selected recipients in the mail merge, click Edit recipient list and select the recipients you want. 
11. Use the rest of  the wizard steps to write, add recipient information, preview, personalize, save, and print or e-mail your documents. For 

more information about these steps, see Word Help. 

Note: 

• While Word has your workbook pen to create the mail merge, you can’t open the workbook in Excel. If  you need to see the data and it’s 
column labels, go to Step 3 or 5 of  the wizard and click Edit recipient list. 

*********************************************************************************************************
This applies to Microsoft Office Excel 2007

If  you want to send a mass mailing to an address list that you maintain in a Microsoft Office Excel worksheet, you can use a Microsoft 
Office Word mail merge. The mail merge process creates a sheet of  mailing labels that you can print, and each label on the sheet contains 
an address from the list. 

To create and print the mailing labels, you much first prepare the worksheet data in Excel and then use Word to configure, organize, review 
and print the mailing labels. 

Step 1: Prepare the worksheet data in Excel for the mail merge
In Excel, your address list must match the tabular structure that mail merge requires.

1. On a worksheet, do the following to arrange the address list:
• Use column headers that clearly identify the type of  data that each column contains.

	 TIP  For example, use column headers such as First Name, Last Name, Street Address, and City instead of  Column 1, 
Column 2, Column 3, and Column 4.

• Use a separate column for each element that you want to include in the mail merge. 
	 TIP You can also use the mail merge to create form letters that address each recipient by their first name, if  you store first and last 
names in separate columns. You can also add a separate column for a title, such as Mr. or Mrs.	
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PRINT LABELS BY USING EXCEL DATA IN A WORD MAIL MERGE (CONTINUED)

• Include only rows and columns that contain data. Do not include blank rows or columns in the address list, because the 
list of  labels that is created might not be complete beyond the blank rows and columns when you set up the labels for the 
mail merge in Word. 

1. To help locate and select the address list during the mail merge, do the following to define a name for the address list:
a. On the worksheet, select the whole address list, including the cells that contain column headers. 
b. On the Formulas tab, in the Defined Names group, click Define Name.


 
 

c. In the Name box, type a name for the address list, such as Holiday_Cards, and then click OK.

	 TIP The first character of  a name must be a letter, and you cannot use a space between words. Instead of  a space, use an 
underscore character (_).

2. Save and close the workbook.

Step 2: Configure the labels for the mail merge in Word
You configure the layout of  the labels just once, for all the labels in the mail merge. In a mail merge, the document that you configure for 
the layout is referred to as the main document for labels (or label main document). In this document, you can also configure any content 
that you want repeated on each label, such as a company logo or your return address on shipping labels.
Chances are that you already have a package of  label sheets from one of  the label sheet suppliers such as Avery AOne, or Formtec. Each 
label sheet is a certain size and contains a certain number of  labels with specific dimensions.
To configure the label main document, you match its dimensions with the dimensions of  the labels on the worksheets that you plan to use. 

1. Start Word
By default, a blank document opens. Leave it open. If  you close it the commands in the next step are not available.

2. On the Mailings tab, in the Start Mail Merge group, click Start Mail Merge.


 

3. Click Labels.
4. In the Label Options dialog box, you have several choices to make. 


 
 



 The type of  printer that you are using to print the labels. 


  The supplier that produced your label sheets


  The number that corresponds to the product number listed on your package of  label sheets.

- If  the product number for the example label sheets does not match any one of  the choices in the Label Options 
dialog box. You can still print your labels, but you have to do some customizing. Measure the labels on the sheet that 
you are using, and note the measurements and how many labels fit on a single sheet.

NOTE: Measure the labels carefully. The actual label size might be a smaller than the size that is 	indicated by the label manufacturer. For 
example, a 1-by-2-inch label might actually be 15/16-inch high and 1 15/16-inches wide.
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	 In the Product number list, select a label type that is similar in size to your labels.

 If  you do not see a substitute label type that you can use in the Product number box, you still might be able to use another one 
of  the listed labels. If  you don’t see a label type that fits your needs, you can create a new label size. 

1. Click Details, and then compare the label dimensions and the number of  labels per sheet or the number of  columns 
on the label form.

2. Do one of  the following:
• If  the dimensions and label layout match those of  your labels, use the selected label.
• If  the dimensions and layout do not match your labels, click Cancel.

3. In the Label Options dialog box, click the printer type (either continuous-feed printer or Page printers), and 
then click New Label.

4. Type a name in the Label name box, select the height, width, margin, and other options for you label, and click OK.
	 The new label appears in the Product number box as Label name - Custom. The label is also added to the the Other/
Custom category. The next time that you use your custom labels, make sure that you select Other/Custom in the Label vendors list.

5. After you select the label options that you want, click OK.
 	 Word creates a document that uses a table to lay out the labels. If  you do not see lines separating the labels in the layout, click the 
Layout tab under Table Tools, and then in the Table group, click View Gridlines. Step 3: Link the worksheet data to the 
labels in the mail merge
To merge the address information into your labels, you must connect the labels to the worksheet that contains your address list. 

1. If  this is the fist time that you have ever connected to a worksheet, do the following:

a. Click the Microsoft Office Button , and then click Word Options.
b. Click Advanced.
c. Scroll to the General section, and select the Confirm file format conversion on open check box.
d. Click OK.

2. With the mail merge main document open, in the Start Mail Merge group on the Mailings tab, click Select Recipients, 
and then click Use Existing List. 


 

3. Locate the Excel worksheet in the Select Data Source dialog box, and double-click it. 
4. In the Confirm Data Source dialog box, click MS Excel Worksheets via DDE (*.xls), and then click OK.

NOTE - If  you do not see MS Excel Worksheets via DDE (*.xls) in the list, select the Show all check box. 
5. In the Microsoft Office Excel dialog box, for Named or cell range, select the cell range or worksheet that contains the 

information that you want to merge, and then click OK.
NOTE - The labels are now connected to the worksheet data, but the sheet of  labels is still blank. If  needed, you can define the list of  
recipients as described in step 4, or you can start populating the labels with placeholders for the address information, as described in step 5.

Step 3: Populate the labels with placeholders for address information
When you perform the mail merge, the mail merge fields are filled with information from your address list.
 
After you connect your labels to your address list, you are ready to add placeholders that indicate where the addresses will appear on each 
label. You can also type text that you want repeated on each label, such as a company logo or your return address on a shipping label.

The placeholders for the addresses are called mail merge fields. Mail merge fields in Word correspond to the column headers in the data file 
that you choose.


 


Columns in a data file represent categories of  information. Mail merge fields that you add to the labels are placeholders for these 
categories. 

 Rows in a data file represent records of  information. Word generates a label for each record when you perform a mail merge.

By putting a mail merge field in the original label that you configured in the label main document, you indicate that you want a certain 
category of  information, such as name or street address, to appear in that location. 

PRINT LABELS BY USING EXCEL DATA IN A WORD MAIL MERGE (CONTINUED)

http://www.caprarotechnologies.com
http://www.caprarotechnologies.com


315.733.0854	 www.caprarotechnologies.com


 

NOTE  When you insert a mail merge field into the label main document, the field name is always surrounded by chevrons (<< >>). 
These chevrons do not show up on the final labels - they just help you distinguish the fields in the label main document from the regular 
text. 

What happens when you merge

When you perform the mail merge, information from the first row in the data file replaces the fields in the first label. Then, information 
from the second row in the data file replaces the fields in the second label, and so on. 


 

Working with fields: Examples
When you design labels, you can link any column heading from your data file to a field in a label. For example, suppose you have a 
subscriber list to your newsletter and your data file includes a column, called ExpireDate, that stores the date that each subscription expires. 
If  you insert an <<ExpireDate>> field in the label main document before you run the merge, that information is added to each mailing 
label. 
You can combine fields and separate them with punctuation marks. For example, to create an address, you can configure the fields in the 
label main document as follows, using a comma between the <<City>> and <<State>> fields. 

<<First Name>> << Last Name>>
<<Street Address>>
<<City>>, <<State>> <<Postal Code>>

For combinations that you use frequently, like address blocks and greeting lines, Word provides composite fields that group a number of  
fields together. For example, the Address Block field is a combination of  several fields, including first name, last name, street address, city, 
state and postal code. 
You can customize the content in each of  these composite fields. For example, in the address, you may want to select a formal name format 
(Mr. Roger Smith). In the greeting, you might prefer to use “To” instead of  “Dear”.

Map the mail merge fields to your data file.

To make sure that Word can find a column in your data file that corresponds to every address element, you might need to map the mail 
merge fields in Word to the column in your data file. 
To map the fields, click Match Fields in the Write & Insert Fields group on the Mailings tab. 




PRINT LABELS BY USING EXCEL DATA IN A WORD MAIL MERGE (CONTINUED)
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The Match Fields dialog box appears.


 

The elements of  an address are listed on the left. Column headings from your data file are listed on the right. Word searches for the column 
that best matches each element. As the graphic illustrates, Word automatically matched the data file’s Surname column to Last Name, 
but Word was unable to match other elements, such as First Name.
In the list on the right, you can select the column from your data file that matches the element on the left. In the graphic the Name column 

is now matched with First Name. It is okay that Courtesy Title, Unique Identifier,  and Middle Name are not matched, because 
mail merge label does not need to use every field. If  you add a field that does not contain data from your data file, it will appear in the 
merged document as an empty placeholder - usually a blank line or an empty block of  space. 
Type the content and add the fields

1. In the original label that you configured in the label main document, click where you want to insert the field. 
2. Use the Write & Insert Fields group on the Mailings tab. 
3. Add any of  the following:

	 Address Block with name, street address, and other information
1. Click the Address Block
2. In the Insert Address Block dialog box, select the address elements that you want to include and the formats that you 

want to apply and then click OK. 
3. If  the Match Fields dialog box appears, this means that Word is unable to find some of  the information that it requires 

to complete the address block. Click the arrow next to (not match), and then select the field from your data source that 
corresponds to the field that is required for the mail merge.

	 Individual fields
	 You can insert information from individual fields, such as first name, telephone number, or the amount of  a contribution from a 
	 list of  donors. To quickly add a field from your data file to the label main document, click the arrow next to Insert Merge Field, 
	 and then click the field name. To insert other optional fields in the document, do the following:

1. On the Mailings tab, in the Write & Insert Fields group, click Insert Merge Field.
2. In the Insert Merge Field dialog box, do one of  the following:

• To select address fields that will automatically correspond to fields in your data source, even if  the names of  those 
fields are not the same as the field names in Word, click Address Fields.

• To select fields that always take data directly from a column in your data file, click Database Fields.
3. In the Fields box, click the field that you want.
4. Click Insert, and then click Close.
5. If  the Match Fields dialog box appears, this means that Word is unable to find some of  the information that it requires 

to insert the field. Click the arrow next to (not matched), and then select the field from your data source that 
corresponds to the field that is required for the mail merge.

 
 
 Note   If  you insert a field from the Database Fields list and then later switch to a data source that does not contain a 

 
 column with the same name, Word will be unable to insert that field information into the merged document.

1. After you finish setting up the first label the way you want it, in the Write & Insert Fields group, click Update Labels. Word 
replicates the layout of  the first label to all the other labels.

 
 Notes 
• You cannot type merge field characters (<<>>) manually or use the Symbol command on the Insert menu in Word. You must 

use mail merge.
• If  the merge fields appear inside braces, such as { MERGEFIELD City }, Word is displaying field codes (field code: Placeholder text 

that shows where specified information from your data source will appear, the elements in a field that generate a field’s result. The 
field code includes the field characters, field type, and instructions) instead of  field results (field results: Text of  graphics inserted in 
a document when Microsoft Word carries out a field’s instructions. When you print the document or hide field codes, the field 
results replace the field codes.).  This doesn't affect the mail merge, but if  you want to display the results instead, right-click the 
field code, and then click Toggle Field Codes.

PRINT LABELS BY USING EXCEL DATA IN A WORD MAIL MERGE (CONTINUED)
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CAPRARO TECHNOLOGIES, INC 

You can now find Capraro Technologies, Inc on  Facebook (http://www.facebook.com/pages/Utica-NY/

Capraro-Technologies-Inc/138676162813774?ref=ts) and Twitter (https://twitter.com/CapraroTech)

Please share this newsletter with your friends and colleagues. For archives of  our previous newsletters you can find 
them online at http://www.cnybit.com/newsletter.
If  you have any comments or suggestions, please email newsletter@caprarotechnologies.com.

Gerard T. Capraro, Ph.D.
President

Capraro Technologies, Inc.
2118 Beechgrove Place, Utica NY 13502

Step 5: Preview and print the labels
After you have added the fields to the original label that you configured in the label main document, you are ready to preview the mail 
merge results. After you are satisfied with the preview, you complete the mail merge and print the labels. You can then save the label 
document for future use.

Preview the mail merge

You can preview your labels and make changes before you actually complete the mail merge.
To preview, do any of  the following in the Preview Results group of  the Mailings tab:

             

• Click Preview Results.
• Page through each label by clicking the Next Record and Previous Record buttons in the Preview Results group on the 

Mailings tab.
• Preview a specific label document by clicking Find Recipient.

	
Note:  Click Edit Recipient List in the Start Mail Merge group on the Mailings tab to open the Mail Merge Recipients dialog 
box, where you can filter the list or remove recipients from the merge if  you see records that you do not want to include.

              
Note: Word uses a table to lay out a sheet of  labels on the page. As you page through the labels, the active record is displayed in the first 
cell of  the table, with the following records displayed in subsequent cells.

Complete the mail merge
To print the labels, do the following:

1. On the Mailings tab, in the Finish group, click Finish & Merge, and then click Print Documents.

            

2. Choose whether to print the whole set of  labels, only the label that is currently visible, or a specific subset of  the labels.

To change individual labels, do the following:
1. On the Mailings tab, in the Finish group, click Finish & Merge, and then click Edit Individual Documents.

2. Choose whether you want to edit the whole set of  labels, only the label that is currently visible, or a specific subset of  the labels. 
Word saves the labels that you want to edit to a separate file.

PRINT LABELS BY USING EXCEL DATA IN A WORD MAIL MERGE (CONTINUED)
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